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Abstrakt. Pri spracovanı́ výsledkov meranı́ a pozorovanı́ sa široko použı́vajú metódy gra-
fického zobrazenia. Čı́selné údaje, ako výsledky meranı́ a pozorovanı́ prezentované v ta-
bul’kovej forme neumožňujú dostatočne názorne charakterizovat’ zákonitosti študovaných
procesov, preto je vhodné tabul’ku doplnit’ grafom. Grafické zobrazenie poskytuje názor-
nejšiu predstavu o výsledkoch experimentu, umožňuje lepšie pochopit’ fyzikálny zmysel
študovaného procesu, odhalit’ všeobecný charakter závislosti premenných veličı́n. V pro-
stredı́ OS GNU/Linux máme bohatý výber programov na spracovanie a analýzu dát, ktoré
sú na rozdiel od komerčného softvéru v OS Windows vol’ne šı́ritel’né vd’aka licencii GPL.
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EXPERIMENTAL DATA PROCESSING AND
ITS GRAPHICAL VISUALIZATION

Abstract. Graphical representation is a method widely used for processing and analysing
measurements and observations results. Their presentation in the form of digital data or
summarized within tables cannot sometimes present the studied processes well, therefore
it may be convenient to add a graph to the table. Graphic imagining may give better insight
into the experimental results and make the physical meaning of the process in hand more
clear as well as to reveal the general character of the functional dependence of the studied
quantities. OS GNU/Linux offers many programs for data processing and analysing which
are, unlike the commercial software under the OS Windows, distributed under GPL licence.
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1 Úvod

Úlohy súvisiace s vyhodnotenı́m experimentálnych dát vo fyzikálnej a technickej praxi sa
vyznačujú týmito základnými vlastnost’ami:

(a) rozsah a objem spracovaných dát obyčajne nie je vel’ký,
(b) v dátach sa nachádzajú aj vybočujúce hodnoty merania a rôzne nehomogenity,
(c) v dátach sa zvyčajne vyskytujú nelinearity, vzájomné väzby a pod., ktoré treba iden-

tifikovat’ a opı́sat’,
(d) parametre modelov majú obyčajne definovaný fyzikálny význam,
(e) často narážame na istú neurčitost’ (nejasnost’, nepresnost’) pri výbere modelu na opis

dát.

Pri projektovanı́ pokusu je experimentátor vedený snahou zı́skat’ z meranı́ čo najviac
fyzikálne zaujı́mavých informáciı́, preto experiment často prebieha za rôznych (kontrolova-
ných) podmienok. Zmenou istých veličı́n sledujeme ich vplyv na iné veličiny. Vo väčšine
prı́padov sa jedná o spojitú funkčnú závislost’ jednej veličiny od druhej veličiny. Napr. tep-
lotnú závislost’ odporu, závislost’ anódového prúdu magnetrónu od indukcie magnetického
pol’a, závislost’ intenzity jadrového žiarenia od hrúbky absorbátora atd’. Nameranı́m závis-
losti veličı́n práca experimentátora nekončı́, naopak, nasleduje najdôležitejšia úloha, a to
fyzikálne interpretovat’výsledky meranı́. Pod pojmom interpretácie rozumieme odôvodnenie
výsledkov. V podstate ide o určenie prı́čin, ktoré spôsobujú daný výsledok. Experimentálna
práca je takto z formálneho hl’adiska „obrátenou“ úlohou k teoretickému postupu, ktorý
z definovaných podmienok (prı́čin) predpokladá závery (následky) a tento fakt treba mat’ na
zreteli pri spracovávanı́ merania. V konkrétnych prı́padoch sa najčastejšie stretneme s týmito
situáciami:

• Fyzikálna interpretácia meranej závislosti nie je dobre prepracovaná, tzn., že v čase
konania experimentu neexistuje teoretický model, ktorý by viac-menej úspešne pred-
povedal tvar funkčnej závislosti. Potom je možné zı́skané závislosti interpretovat’ iba
kvalitatı́vne, resp. v jednoduchých prı́padoch vyslovit’ hypotézu (napr. o lineárnej,
resp. inej závislosti).

• Teoretický model predpovedá očakávanú závislost’, napr. y= a+ bx. Experiment6

lineárnu závislost’ potvrdı́. Treba nájst’ „správne“ hodnoty parametrov, napr. a, b,
ktorým môžu zodpovedat’ d’alšie dôležité informácie. Úlohami tohto druhu sa zaoberá
vyrovnávacı́ počet. V súčasnej dobe sa široko využı́va metóda najmenšı́ch štvorcov.
Za správne hodnoty sa považujú také hodnoty parametrov, ktoré dávajú najmenšı́
súčet druhých mocnı́n odchýlok medzi nameranými a teoreticky predpovedanými
hodnotami. Uvedieme hlavné črty metódy.

6Experiment môžeme rozdelit’ na časti, ktoré sú do istej miery samostatné, voláme ich pokusy.
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Majme nameranú funkčnú závislost’ fi= f (xi) v bodoch i=1, 2, . . . ,n. Teoretický model
predpokladá závislost’ y=F(x, p1, p2, . . . , pk), kde p1, p2, . . . , pk sú parametre, ktoré sa
nedajú vypočı́tat’ v rámci tohto modelu (čı́m menej parametrov, tým je model hodnotnejšı́),
pričom tvar funkcie F nepoznáme. Odchýlky modelovej F∗ a experimentálej funkcie fi,
vypočı́tané v nameraných bodoch, označı́me ei

ei = F∗(xi, p∗1, p∗2, . . . , p∗k)− fi. (1)

Vzhl’adom na to, že považujeme kladné odchýlky za rovnako významné ako záporné, uva-
žujeme druhú mocninu ei.7 Ďalej označı́me

Φ=
n

∑
i=1

ei
2. (2)

Úlohou je nájst’ také odhady p̂1, p̂2, . . . , p̂k parametrov p1, p2, . . . , pk, pre ktoré funkcia Φ
(označovaná tiež ako účelová alebo kriteriálna) nadobúda minimum. Aby mala táto po-
žiadavka zmysel, musı́ byt’ splnených niekol’ko nie práve samozrejmých predpokladov,
o ktorých sa musı́me pred začatı́m experimentu presvedčit’, pozri napr. [3, I., str. 74]:

1. chyba nezávisle premennej xi je zanedbatel’ne malá vzhl’adom na chybu
závisle premennej fi,

2. chyba merania premennej fi je náhodná veličina z normálne rozdeleného
súboru, ktorý má nulovú strednú hodnotu a konštantný rozptyl v celej
oblasti merania.8

Nutnou podmienkou pre minimum je potom splnenie rovnice

∂Φ
∂ p∗j
= 2

n

∑
i=1

ei
∂ei

∂ p∗i
= 2

n

∑
i=1

ei
∂F∗(xi, p∗1, . . . , p∗k

)
∂ p∗j

= 0 , j = 1,2, . . . ,k. (3)

Túto sústavu je možné explicitne riešit’v niektorých špeciálnych prı́padoch. Všeobecne treba
použı́vat’ vybrané numerické metódy [1, 2, 7–9, 11].

Na spracovanie údajov, kreslenie grafických závislostı́ a ilustráciı́ existujú open source
programy, ktoré sú bohato vybavené podprogramami na interpoláciu aj extrapoláciu, na
fitovanie (nájdenie najlepšej aproximácie) nameranej závislosti zvolenou triedou funkciı́ a na
optimalizáciu. Navyše, tieto programy poskytujú aj prostriedky na štatistické spracovanie
výsledkov, vyhladenie závislostı́, rôzne filtre a pod. Do tejto kategórie patria aj dva výborné
open source programy QtiPlot a Kpl.

7Všeobecne sa uvažuje nejaká párna funkcia, t. j. funkcia f (x) taká, že f (x)= f (−x). Druhej mocnine sa
dáva prednost’ pred absolútnou hodnotou, lebo je to hladká funkcia.

8Systematické chyby ovplyvňujú experiment v rovnakom zmysle, ale vo všeobecnosti všetky merania rôznou
hodnotou. Majú nenulovú strednú hodnotu a prejavujú určitú mieru vzájomnej závislosti, t. j. sú korelované.
Nedodržanie predpokladu náhodnosti a nezávislosti chýb i nenulovosti ich stredných hodnôt znemožňuje použitie
štatistických metód vyhodnotenia.
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2 Použitie programu QtiPlot

QtiPlot je výkonný programový balı́k, ktorý poskytuje ako jednoduché tak aj vel’mi zložité
nástroje na analýzu dát a na kreslenie grafov. V tomto prı́spevku sa budeme venovat’ opisu
verzie QtiPlot 0.8.5 v prostredı́ OS GNU/Linux distribúcie UBUNTU 6.06. Domovská
internetová stránka programu je na URL adrese http://soft.proindependent.com/

qtiplot.html odkial’ sa dá program stiahnut’. Na prácu v QtiPlote existujú dva druhy
okien (pracovných prostredı́):

• tabul’kové
• a grafické.

Tabul’kové okno zobrazuje dáta potrebné na tvorbu grafu. V grafickom okne je vyobrazený
graf vytvorený z týchto dát. Podl’a toho, ktoré z okien je aktı́vne, tabul’kové alebo grafické,
menı́ sa obsah hlavnej ponuky. Vzhl’adom na rozsah možnostı́, ktoré poskytuje program
QtiPlot, ukážeme na konkrétnom prı́klade niektoré funkcie a ponuky QtiPlotu, ktoré sú
potrebné na numerické spracovanie experimentálnych dát a ich grafickú prezentáciu.

Obrázok 1: Tabul’kové okno s importovanými dátami
boxbod.dat

Graf vo všeobecnosti chápeme ako gra-
fické zobrazenie funkcie y = f (x), pričom
x je nezávisle a y závisle premenná ve-
ličina. V tabul’kovom okne vkladáme do
stĺpca 1[X] nezávisle premennú a do stĺpca
2[Y] a d’alšı́ch stĺpcov 3[Y], 4[Y] atd’. zá-
visle premenné. Počet premenných definu-
jeme podl’a našich požiadaviek, v prı́pade
potreby vytvárame d’alšie stĺpce prı́kazom
Table → Add column alebo pravým kli-

kom myši v hlavičke tabul’ky vyberieme z kontextového menu Add column. Na našu ukážku
použijeme certifikované dáta z internetovej stránky Národného inštitútu štandardov a techno-
lógiı́ Spojených štátov amerických [4]. Stiahli sme si dáta z kolekcie pre nelineárnu regresiu
s názvom BoxBOD9, ktoré sú zaradené do kategórie s vysokou náročnost’ou na spracovanie.
Tabul’ka bola uložená do dátového súboru s názvom boxbod.dat. Tento súbor teraz impor-
tujeme, postupným vyvolanı́m nasledovných ponúk File → Import ASCII → Set import
option, nastavı́me formát importovaných dát a potom vykonáme import dát do tabul’ky, napr.
z nástrojovej lišty kliknutı́m na ikonu

Vyhl’adáme súbor boxbod.dat, po vol’be sa údaje prenesú do tabul’ky, pozri obrázok 1.

9 http://www.itl.nist.gov/div898/strd/nls/nls_main.shtml

http://soft.proindependent.com/qtiplot.html
http://soft.proindependent.com/qtiplot.html
http://www.itl.nist.gov/div898/strd/nls/nls_main.shtml
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Obrázok 2: Zobrazenia dát tabul’ky z obrázku 1

Kliknutı́m do hlavičky tabul’ky a t’ahom myši
(alebo stlačenı́m klávesuShift a súčasným po-
hybom klávesových šı́pok) vyznačı́me stĺpce
závisle a nezávisle premennej a z hlavného
menu zvolı́me Plot → Scatter. Vykreslia sa
body do grafu s názvom graph 1 (obrázok 2).
Aproximujme dáta znázornené v grafe na ob-
rázku 2 exponenciálnou závislost’ou v tvare

y= a[1− exp(−bx)],

ktorá je podl’a [4] modelovou funkciou pre
tieto dáta. V hlavnom menu klikneme na po-
ložku Analysis → Non-linear Curve Fit . . .
a vyberieme ponuku User defined. Do l’avého

dolného okna zapı́šeme aproximačnú funkciu a*(1-exp(-b*x)), do okienka Name vpı́-
šeme názov funkcie, napr. boxbod, do okienkaParameters vpı́šeme symboly a, b fitovaných
parametrov oddelených čiarkou a medzerou, potom kliknutı́m na položku Save vytvorenú
funkciu uložı́me (objavı́ sa v zozname Function). Klikom myši na prvok zoznamu z okna
Category sa zobrazı́ v okne Function zoznam funkciı́ z danej kategórie (vybrané položky sa
podfarbia modrou farbou). Vyberieme si samozrejme tú našu boxbod. V prı́prave na fito-
vanie pokračujeme zaškrtnutı́m polı́čka Fit with selected user function a potom kliknutı́m
na položku Fit>>. Otvorı́ sa okno, v ktorom nastavı́me štartovacie hodnoty Initial gues-
ses, vyberieme algoritmus fitovania, rozsah nezávisle premennej, maximálny počet iteráciı́
a toleranciu na ukončenie procesu. Kliknutı́m na položku Fit sa odštartuje fitovanie a po
jeho ukončenı́ sa na pracovnej ploche objavı́ tabul’ka Result Log s výsledkami, pričom sa
v grafe zobrazı́ regresná krivka (obrázok 3). Výsledky fitovania môžeme vložit’do pol’a grafu
kopı́rovanı́m tabul’ky cez schránku, pričom môžeme použit’ postup na editovanie a vklada-
nie textu do plochy grafu Graph → Add text. Výsledok vidı́me znázornený na obrázku 3
a uvádzame tu aj tabul’ku výsledkov:

16.09.2006 00:08:27 Fit1:
Non-linear fit of table3_2,
using function boxbod(x, a, b)=a*(1-exp(-b*x))
Scaled Levenberg-Marquardt algorithm with tolerance = 0.0001
From x=1 to x=10
a=213.811069200896 +/- 0.723006
b=0.547218222427426 +/- 0.00611864
-----------------------------------
Chi^2/doF = 292.002
-----------------------------------
Iterations = 7
Status = success
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Obrázok 3: Nelineárna regresia dát BoxBOD exponen-
ciálnou funkciou

Výpis nás informuje o dátume a čase fito-
vania, že toto fitovanie údajov z tabul’ky
table3 2 funkciou boxbod je prvé v tomto
projekte, urobené nelineárnou metódou
použitı́m Levenbergovho-Marquardtovho
algoritmu s toleranciou 0.0001. Ďalej sa
uvádza rozsah nezávisle premennej x, fito-
vané parametre a a b so štandardnými ne-
istotami, hodnota χ̃2= χ2/(n−k) (redu-
kovaná hodnota funkcie chı́ kvadrát χ2,
pozri [5,10]), počet iteráciı́ a napokon hlá-
senie, že proces fitovania bol ukončený
úspešne.

Program QtiPlot počı́ta redukovanú
hodnotu χ2 označenú ako Chi^2/doF,
kde doF znamená Degrees of Freedom

čiže n− k a štandardná neistota parametra je určená podl’a vzt’ahu

σ
qti =

√
(cov)ii

Chiˆ2/doF
. (4)

Na internetovej stránke inštitútu NIST sa však dočı́tame, že ich údaj štandardnej neistoty
parametra sa počı́ta podl’a vzt’ahu

σ
nist =

√
(cov)ii , (5)

kde (cov)ii je v oboch prı́padoch kovariančná matica parametrov regresie, pozri napr. v prá-
cach [5, 6]. Pri rovnosti kovariančných matı́c, potom súvis oboch údajov môžeme vyjadrit’
vzt’ahom

σ
nist = σ

qti√Chiˆ2/doF. (6)

Ked’teda potrebujeme výsledok numerického spracovania dát regresiou programomQtiPlot
uviest’ so štandardnou neistotou hl’adaných parametrov, musı́me tento „nedostatok“ výpočtu
programu korigovat’ použitı́m vzt’ahu (6), štandardná neistota parametra regresie sa uvádza
v takom tvare, ako na internetovej stránke inštitútu NIST.

3 Použitie programu Kpl

Program Kpl je jednoduchý z pohl’adu ovládania, poskytuje však rozsiahle možnosti na
vyhladzovanie, optimalizáciu a numerické operácie s nameranými dátami (napr. derivova-
nie, integrovanie); môžeme ho dopĺňat’ vlastnými funkciami a knižnicami, ktoré sa napı́šu
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a skompilujú v programovacom jazyku C. Na rozdiel od programu QtiPlot neumožňuje
štatistické výpočty a charakteristiky dát. Domovská internetová stránka programu je na
adrese http://frsl06.physik.uni-freiburg.de/privat/stille/kpl/. Na prácu
v Kpl máme k dispozı́cii jedno pracovné okno.

Obrázok 4: Importovanie a zobrazenie dát metódou t’a-
haj a pust’

Program Kpl má sı́ce vlastný editor ta-
buliek, ale s obmedzenými možnost’ami
formátovania, preto si na vytvorenie ta-
bul’ky vyberme radšej nejaký textový
ASCII editor (napr. Kate, gedit, KSpread
a pod.). Dátový súbor vytvárame a editu-
jeme v stĺpcovom formáte, a pri jeho ukla-
danı́ do pracovného priečinka mu pridá-
vame prı́ponu dat. Symbolom desatinnej
rádovej čiarky môže byt’desatinná čiarka
alebo desatinná bodka a ako oddel’ovač
(separátor) stĺpcov odporúčame použit’ ta-
bulátor (Tab) alebo medzernı́k (Space).
Dátový súbor môžeme importovat’dvoma
spôsobmi: (a) Vyvolanı́m ponúk File →
Open Data File . . . sa otvorı́ dialógové

okno, v ktorom zvolı́me symbol desatinnej rádovej čiarky a vyhl’adáme na disku súbor na
importovanie. (b) Otvorı́me program Kpl a potom nejaký program na spravovanie súbo-
rov (napr. Konqueror alebo Krusader), v ktorom vyhl’adáme súbor, ktorý chceme zobrazit’.
Označı́me ho l’avým klikom myšky a t’ahom ho premiestnime do okna programu Kpl, kde
klik uvol’nı́me (metóda Drag and Drop), pozri obrázok 4.

Obrázok 5: Pracovné okno položky Items . . .

„Surový“ graf z obrázku 4 môžeme upravo-
vat’ vyvolanı́m položky Items . . . Aktivuje
sa dvoma spôsobmi, pravým klikom myši do
prázdneho pol’a v okne programu (mimo pol’a
grafu) a z kontextového menu vyberieme žia-
danú položku alebo vyvolanı́m ponúk Edit
→ Items . . . , pozri obrázok 5. Tak, ako v prı́-
pade programu QtiPlot aproximujme dáta

znázornené v grafe na obrázku 4 exponenciálnou závislost’ou v tvare

y= a[1− exp(−bx)],

ktorá je podl’a [4] modelovou funkciou pre tieto dáta.Kpl implicitne takúto funkciu neponúka,
ale môžeme ju napı́sat’ ako program v jazyku C, napr. boxbod.c, a skompilovanı́m vytvorit’
knižnicu (modul) boxbod.so.
Postup je nasledovný: v textovom editore napı́šeme naprı́klad takéto funkcie v jazyku C.
Prvá plotfunc bude na vykreslenie fitovanej čiary do grafu, druhá fitfunc na iteráciu:

http://frsl06.physik.uni-freiburg.de/privat/stille/kpl/
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/****************************************************************/
/* boxbod.c 2D functions for Kpl */
/* */
/* Copyright (C) 2006 by Ladislav Sevcovic */
/* <ladislav.sevcovic@tuke.sk> */
/* */
/* Released under the GPL; see file LICENSE for details. */
/* */
/* Use the following command to compile the C function */
/* and create a shared library: */
/* gcc -Wall -shared -fPIC -o boxbod.so boxbod.c -lm */
/* Do this in a X terminal windows (shell). */
/* At the X terminal type: nm boxbod.so>boxbod.def */
/* */
/* exponential(x, p) calculates of exponential */
/* Returns: p[0] * (1 - exp(-p[1] * x)) */
/****************************************************************/
#include <math.h>
/****************************************************************/
double plotfunc(double x, const double* p)
{
return(p[0] * (1 - exp(- p[1] * x)));
}
/****************************************************************/
double fitfunc(double x, const double* p)
{
int i;
double f;
f = p[0];
for (i = 0; i < 3; i += 1)
f == p[i] * (1 - exp(- p[i + 1] * x));

return f;
}
/****************************************************************/

Súbor uložı́me do pracovného priečinka pod menom boxbod.c a do prı́kazového riadka
v okne X terminálu najprv napı́šeme

gcc -Wall -shared -fPIC -o boxbod.so boxbod.c -lm

Stlačnı́m klávesuEnter spustı́me kompiláciu nášho programu do binárnej knižnice boxbod.so.
Potom napı́šeme

nm boxbod.so>boxbod.def

Opätovným odoslanı́m vytvorı́me tabul’ku symbolov.10 Dva skompilované súbory boxbod.so
a boxbod.def použijeme na fitovanie, presuňme ich teda do pracovného priečinka, v ktorom
máme ostatné súbory s dátami pre Kpl alebo do osobitného podpriečinka, v ktorom budú len
knižnice (aj budúce).

10Súčast’ou OSGNU/Linux je aj kompilátor gcc jazyka C a rad d’alšı́ch programátorských nástrojov. Program
nm vytlačı́ tabul’ku symbolov (zoznam názvov) v abecednom poradı́ pre jeden alebo viac objektových súborov.
Výstup obsahuje pre každý symbol meno, hodnotu, typ, vel’kost’ a pod.
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Obrázok 6: Výsledný graf s fitovanou krivkou pre dáta boxbod.dat

Teraz už môžeme začat’ s fi-
tovanı́m dát. V okne položky
Items klikneme na ponuku New
a potom na ponuku Function.
Vyhl’adáme si našu knižnicu
boxbod.so a z nej vyberieme
funkciu plotfunc, doplnı́me
xmax na 10, nastavı́me symbol,
vel’kost’ a farbu fitovacej čiary
v grafe a výber ukončı́me potvr-
denı́m Apply a potom OK. Prej-
deme opät’ do okna Items, kde

klikneme na novovytvorenú položku Function a potom na okienko Fit, čı́m sa nám ot-
vorı́ okno Parameter fit. Zaškrtneme l’avé okienka × pre parametre p0 a p1 a do pravých
vpı́šeme ich štartovacie hodnoty, pre p0=100 a pre p1=0.75. Fitovanie bude nelineárne,
preto zaškrtneme aj okienko × Nonlinear fit. Kliknutı́m do položky Model sa otvorı́ okno
Error model function, v ktorom opät’ vyhl’adáme knižnicu boxbod.so a z nej tentoraz vybe-
rieme funkciu fitfunc, ako argument zvolı́me ycolumn. Kliknutı́m na položku Edit zadáme
štartovacie parametre iteračného procesu (stačı́ napr. p0=1). Výsledné parametre fitovanej
funkcie y=p[0]*(1-exp(-p[1]*x)) sa vpı́šu do prı́slušných okienok parametrov. Kliknutı́m
na položku Apply sa výsledok fitovania zobrazı́ v grafe, ako spojitá krivka (obrázok 6).
Prácu s fitovanı́m ukončı́me kliknutı́m na položkuOK. Do grafu vložı́me legendu, názvy osı́
a pod., pre viac informáciı́ o úprave grafov pozri [10, str. 65].

4 Záver

Ked’hovorı́me o vyhodnocovanı́ experimentálnych dát a o ich prı́prave na d’alšiu prezentá-
ciu s použitı́m osobného počı́tača, potom samozrejme musı́me venovat’ náležitú pozornost’
nielen samotným programom, ale aj metódam a postupom spracovania dát. Stručný opis
použitia dvoch známych produktov z tejto oblasti nám v základoch objasnil ich niektoré
špecifické vlastnosti a ukázal, že aj open source softvér disponuje dostatočnou kvalitou,
ktorá nezaostáva za drahým komerčným softvérom (v mnohých prı́padoch pre bežného pou-
žı́vatel’a nedostupným). Mali sme možnost’ pracovat’ aj s programom Origin 6.111, ktorému
sa opisovaná verzia QtiPlot 0.8.5 svojimi možnost’ami a ponukou najviac približuje. Čo sa
týka rozdielu z pohl’adu bežného použı́vatel’a,QtiPlotmá menšı́ výber formátov pre grafický
výstupu. Nepokladáme to ale za taký vel’ký nedostatok. Origin 6.1 má však lepšie vypra-
cované možnosti napr. ponuky Analysis v grafickom móde a rozšı́renejšiu ponuku modulu
Non-Linear Curve Fit. . . , lepšiu 3D grafiku a iné, ktoré nám však pri štandardnej práci

11Komerčný program, cena aktuálnej verzie Origin 7.5 je asi 19 000,– SKK bez DPH.
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s programom nebudú chýbat’.
Okrem programov QtiPlot a Kpl existuje vel’a d’alšı́ch OSS programov použitel’ných na

účely spracovania a grafického zobrazenia dát, uved’me naprı́klad: Labplot, Octave, Pylab,
Grace, R.
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[6] KUDRACIK, F.: Spracovanie experimentálnych dát. Bratislava : Univerzita Komen-
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